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ATTN: Document Control Desk
Washington, DC 20555
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SUBJECT: Emergency Planning Implementing Procedure and Index

In accordance with 10 CFR 50.54(a), 10 CFR 50, Appendix E, Section V, and 10 CFR 50.4(b)(5), please find the procedure
EPIIP-EOF-6 Rev 49 enclosed for the Document Control Desk (holder of Copy 165) and the NRC Region TV Plant Support
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REMOVE SECTION JINSERT SECTION
EPIiP-EOF-6 Rev 49 issued 11/19/2015 EPIIP-EOF-6 Rev 49 issued 12/22/2015

This change was reviewed and does not constitute a decrease in effectiveness.

No commitments are made in this letter.
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Bradley H. Blome

Manager - Site Regulatory Assurance
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Summary Analysis Report
EPIP-EOF-6, Revision 49

On 12-22-2015, Revision 49 of EPIP-EOF-6 was re-issued. The first time Revision 49
was issued, the front cover said Revision 49 and all of the other page headers said
Revision 48 mistakenly. This re-issue of Revision 49 of EPIP-EPF-6 was only to correct
the Revision numbers in the headers. This is editorial, not a reduction in effectiveness,
and continues to comply with Regulations.
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room. Proprietary information
includes personnel names,
company telephone numbers,
and any information, which could
impede emergency response.
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Offsite Dose Assessment using the Unified
RASCAL Interface

Revision 49

Safety Classification:

II Non-Safety

Usage Level:

I Reference

Change No.: EC 67069
Reason for Change: Added reference to Procedure Overview, referencing

Condenser Off Gas alignment to the stack per 0I-CE-1
and post-accident sampling per CH-SMP-0005.

Preparer: C. Worthing
Sponsor: S. Gebers
Owner: C. Worthing
Issued: 11-19-15 3:00 pm

Fort Calhoun Station



EPIP-EOF-6 Reference Use Page 2 of 47Offsite Dose Assessment Using the Rev. 49
{fO Unified RASCAL Interface

1.0 PURPOSE AND SCOPE

1.1 Purpose

1.1 .1 This procedure provides the instructions for performing offsite dose
assessment using the Unified RASCAL Interface (URI) by the On-Shift and
ERO Dose Assessors.

1.1 .2 This procedure provides the instructions for performing down river dose
projects for Liquid Releases.

1.2 Scope

1.2.1 This procedure covers the operation of the URI dose assessment program

and the EXCEL spread sheet for liquid dose projections.

2.0 DEFINITIONS

2.1 ATWS: Anticipated Transient Without SCRAM.

2.2 Committed Dose Equivalent (CDE): The internal dose equivalent to parts of the body
tl •1(individual organs) that will be received from an intake of radioactive material by an

individual over a 50-year period of time.

2.3 Committed Effective Dose Equivalent (CEDE): The internal dose equivalent to parts of
the body (individual organs) that will be received from an intake of radioactive material
by an individual over a 50-year period of time weighted for the relative radiosensitivity
and risk associated with the individual organ and summed for the entire body.

2.4 Deep Dose Equivalent (DDE): The dose equivalent to the whole body that Will be
received from radiation external to the body.

2.5 Effective Dose Equivalent (EDE) is the sum of the products of the dose equivalent to
the organ or tissue (HT) and the weighting factors (MVT) applicable to each of the body
organs or tissues that are irradiated (HE = ZWTHT).

2.6 Maximum Contaminant Level (MCL): Environmental Protection Agency limit for beta
particle and Photon Radioactive for safety drinking water (4-mrem per year).

2.7 Protective Action Guidelines (PAGs): Radiation exposure guidelines which are used to
determine when appropriate protective actions are to be taken on the part of
emergency workers and the general public. These actions typically include sheltering
and evacuation.

2.8 Protective Action Recommendations (PARs): A recommendation made by company
[,•/ personnel to the offsite authorities on the appropriate protective actions to be taken on

.. ,•rthe part of the general public. The PARs are based on plant conditions or dose
projections using the PAGs for guidance.
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2.9 Total Effective Dose Equivalent (TEDE): A method of converting exposure to radiation
to the biological effects that it will cause to the human body. It combines the external
and internal ionizing radiation exposure. The TEDE is the sum of Deep Dose
Equivalent and Committed Effective Dose Equivalent.

3.0 RESPONSIBILITIES

3.1 The Manager-Emergency Planning, is responsible for:

3.1 .1 Ensuring that, as part of initial and requalification training, individuals are
provided with information on the purpose and use of the Interface software
and appropriate precautions associated with its use.

3.1 .2 If the transfer of dose assessment to the EOF is delayed, then the Control
Room Dose Assessment Specialist shall relieve the on-shift Dose Assessor
per their applicable checklists and perform required dose assessments.

3.1.3 The EOF shall relieve the On Shift or Control Room Do•se Assessment
Specialist of the responsibility for dose assessment per their applicable
checklists and perform required dose assessments.

4.0 PROCEDURE

4.1 Overview

4.1.1 Unified RASCAL Interface (U RI) shall be used only when an emergency has
been declared or events require the calculation of radiological doses due to
an actual or potential release of radioactive materials near or beyond the site
boundary.

4.1.2 Emergency Liquid release projection spread sheet shall be used only when
an emergency has been declared or events require the calculation of
radiological doses due to an actual or potential release of radioactive
materials into the Missouri river.

4.1 .3 Attachments 3 - 9 provide instructions for utility modules and field team
calculations.

4.1.4 URI can only calculate doses for a single release pathway at one time.

A. IF releases are occurring via multiple release pathways,
T'HEN
RUN individual dose assessments for each release and ADD together
using the summation process.
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4.1.5 URI contains many reports and operations that can be useful when running
or evaluating dose assessment data. These functions may not be explicitly
called within the body of this procedure. These may be attached to the end
of the procedure.

4.1.6 IF the Condenser Off-Gas radiation monitor RM-057 is greater than 1 E+07-
cpm.
THEN request Operations to align Condenser Off-Gas to the Auxiliary
Building stack per 01-CE-I.

4.1.7 IF Auxiliary Stack radiation monitors RM-062/RM-063 are out-of-service.
THEN RM-052 should be used to monitor effluent and implement CH-SMP-
PA-0005 for accident range effluents.

4.1.8 IF both RM-052 and RM-062 are out-of-service.
THEN implement CH-SMP-PA-0005.

4.2 Start up

4.2.1 START the URI application

0 4.2.2 IF" the program fails to start
OR an error occurs,
THEN
either GO TO another computer that has the program loaded or SEE
Attachment 1 for further instructions.

4.2.3 IF dose assessments are being run during a drill or exercise,
THEN
CHECK the 'Print "This is a Drill" on all reports'.

A. This will automatically indicate that the data is for a drill on all printed or
viewed reports.

4.2.4 SELECT Rapid Assessment from the File menu or toolbar (Lightning Bolt
icon) step 4.3 or SELECT Detailed Assessment from the File menu or toolbar
(Cloud icon) step 4.4

4.2.5 IF assessment data is already available,
THEN
SELECT Sum Assessment from the file menu or toolbar (blue Sigma icon)
step 4.5.
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4.3 Rapid Dose Assessment

4.3.1 DETERMINE the Source Term as follows:

A. IF the Fuel Clad barrier has been declared as a Loss or Potential Loss
per the Emergency Action Levels,
THEN
SELECT Fuel Clad Damage as Yes.

B. IF the Fuel Clad barrier remains intact per the Emergency Action Levels
THEN
SELECT Fuel Clad Damage as No.

C. IF the Reactor Power Level has changed by >= 15% / hour since the
start of the event,
THEN
SELECT Conditions for Coolant Spiking as Yes,
OTHERWISE SELECT Conditions for Coolant Spiking as No.

D. IF damage has occurred to spent fuel,
THEN"
SELECT Damaged Spent Fuel Assembly

4.3.2 DETERMINE the Reactor Shutdown status as follows:

A. For Non-ATWS events:

1. IF the reactor is NOT shutdown,
THEN
ENSURE the Reactor Shutdown checkbox is unchecked.

2. IF the reactor is shutdown,
THEN
CHECK the Reactor Shutdown checkb~ox.

3. ENTER the Date and Time the reactor was shut down.

4. IF a spent fuel event,
THEN
CHECK the Last Irradiated checkbox.

5. ENTER the Date and Time core with the involved fuel assembly was
shutdown.
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B. For ATWS events

1. IF the reactor power is >=2%,
THEN
ENSURE the Reactor Shutdown checkbox is unchecked.

2. IF the reactor power is <2%,
THEN
CHECK the Reactor Shutdown checkbox

3. ENTER the Date and Time the reactor power was reduced below
2%.

4.3.3 SET the meteorological data as follows:

A. SELECT the applicable meteorological tower by checking the
corresponding checkbox in the "Use" column of the Meteorological Data
table.
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w * NOTEI'
j IOnly ONE on-site tower may be selected for any single assessment.j

___ JCurrently URI only uses the FCS meteorological tower for input.________

B. IF multiple towers are present,
THEN
SELECT the tower that best represents the release point height.

C. IF the meteorological data is available from the plant computer system,
THEN
ENTER the following:

* Wind Speed in the appropriate units
* Wind Direction the wind is coming FROM
* AT or the Stability Class directly

D. IF the meteorological data is not available .from the plant computer
system,

STHEN see Attachment 2 for further instructions for dtringWind
Speed, Wind Direction and Stability Class.

E. SELECT the precipitation status that best represents the current
precipitation.

1. IF precipitation is unknown,
THEN
SELECT "None" from the dropdown list and use the following as
guidance:

* None - No rain or snow (most conservative).
* Light Rain - Drizzle, < 0.1 inches / hour.
* Moderate Rain - Heavy Drizzle, 0.1 to 0.3 inches I hour.
* Heavy Rain - > 0.3 inches I hour.
* Light Snow - Visibility > 0.63 miles.
* Moderate Snow - Visibility 0.31 to 0.63 miles.
* Heavy Snow - Visibility < 0.31 miles.

4.3.4 DETERMINE the Release Duration

A. ENTER the estimated Release Duration (4-hours is default).
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4.3.5 SELECT the Release Point Pathway that BEST represents the release in
progress.

A. Additional detail for each pathway, including available effluent monitors,
is available by hovering the mouse over each pathway description.

4.3.6 DETERMINE if the effluent monitors are available.

A. In some cases effluent monitors may not be available even if they are
associated with a release pathway due to plant conditions, such as loss
of power, sample flow, or detector failure.

B. IF unavailable go to step 4.3.12

4.3.7 IF effluent monitors are available for the selected pathway,
THEN
SELECT Yes as this is the preferred method for performing dose
assessments.

4.3.8 IF multiple monitors or multiple lists of monitors are presented,
THEN
SELECT the appropriate monitor.

4.3.9 ENTER the monitor reading for the selected monitor.

4.3.10 Depending on the pathway selected and the associated selected monitor
effluent flow rate data may be required. DETERMINE applicable flow as
follows:

A. IF a Release Point Flow Rate is requested,
THEN
ENTER the flow rate in the units requested.

B. IF a Calculated SIG Flow Rate is requested,
THE._.NN
ENTER the following for the faulted Steam Generator only:

* Pressure
* Number of SRV's (Large Main Steam Safety Valves ) or PORV's

(Small Main Steam Safety Valves MS-291 or 292) open
* Number of ADV's (HCV-1 040) open

C. IF a Calculated Steam Table Flow Rate is requested,
THE._N.
SELECT either Temperature or Pressure from the options an.dd ENTER
the corresponding system parameter value.
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D. ENTER the Mass Flow rate. For ADV (HCV-1 040) enter the mass flow
usina the Dercent open chart.

4.3.11 Go to step 4.3.15

4.3.12 IF effluent monitors are NOT available for the selected pathway,
THEN
SELECT No. Depending on the pathway selected the following options are
available.
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4.3.13 IF the Estimated RCS Leak Rate option is enabled,
THEN
ENTER the Reactor Coolant System leak rate in gpm
OR
SELECT the "I Don't Know" option. An assumed leak rate will be calculated.

4.3.14 IF the Containment Leakage option is enabled,
THEN
ENTER the High Range Area monitor reading
OR
SELECT the "No HRA Available or Applicable" option. Calculated damage
assumptions will be used.

4.3.15 IF accident is spent fuel and monitors and containment leakage are not
applicable
THEN
SELECT Unmonitored Damaged Spent Fuel Assembly.

• ~NOTEi

( I If any errors are present there will be an exclamation point (!) on theI
'• " Process Assessment button and the assessment will not continue until the

____errors are corrected.

4.3.16 PRESS the "Process Assessment" button to run the dose assessment.

4.3.17 SELECT Print or Print Preview from the Menu or Toolbar to view or print the
dose assessment results.

4.3.18 PROVIDE the dose assessment to the Shift Manager or Protective Measures
for comparison to the Emergency Action Levels (EAL) and the Current
Protective Action Recommendation (PAR).

4.3.19 No protective action recommendations are made by the dose assessment
software. USE the protective action procedure (EPIP-EOF-7) to determine
the appropriate response to the dose assessment results.

4.3.20 Repeat atmospheric dose assessment steps as appropriate steps 4.3 or 4.4.

4.4 "DETAILED" Dose Assessment

4.4.1 SELECT Detailed Assessment from the File menu or toolbar (Cloud icon).
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4.4.2 DETERMINE the Source Term as follows:

A. CONTACT technical support to determine the Source Term for the
assessment based on the core conditions and/or type of accident that
has occurred.

B. IF the source term is from the Reactor Coolant System (RCS) WITHOUT
core damage,
THEN
SELECT Normal Coolant.

C. IF any of the following have occurred:

1. The reactor has changed power level by >= 15% / hour since the
start of the event.

2. A rapid depressurization of the RCS has occurred of sufficient
magnitude to require safety injection.

3. Chemistry has determined or reported that a RCS DEl spike has
occurred.•

)
THEN
CHECK the Spiking checkbox.

D. IF Spiking was selected,
THEN
DETERMINE the Spiking Factor:

A sikng acorcanotbeNOTE i

AI pkn ato antb less than 1 or greater than 1000. A spiking factor
• of 335 is the default and a spiking factor up to 1,000 is allowed by the

__ _ Isoftware."___

E. IF a post power change RCS DEl sample result is available,THEN
CALCULATE the Spiking Factor as follows:

1. SELECT Calculations Spiking Factors from the menu and ENTER
the DEl concentration.

2. IF the calculated Spiking Factor is < 335,
THEN
ENTER the calculated value.
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3. IF the calculated Spiking Factor is >_ 335,
THEN
ENTER the value up to 1,000.

F. IF a post power change RCS DEl sample is NOT available,
THEN
ACCEPT the default Spiking Factor (335).

4.4.3 IF the source term is from the RCS WITH core damage,
THEN
SELECT Reactor Core Accident.

4.4.4 SELECT the Type of Damage as determined by technical support.

4.4.5 IF the information is not available,
T-HEN
SELECT Clad.

4.4.6 IF the source term is from damage to spent fuel,
THEN

I / SELECT Spent Fuel Accident.

A. IF the spent fuel release is unmonitored,
THEN
SELECT Un-Monitored Spent Fuel Accident with No other method
available.

4.4.7 IF the source term is from a Waste Gas Decay Tank,
THEN
SELECT Waste Gas Decay Tank.

4.4.8 Enter the Site Meteorological Tower data as follows:

A. SELECT the applicable Site meteorological tower to be used in the
assessment by checking the corresponding checkbox in the "Use"
column of the Meteorological Data table.

B. IF multiple Site Towers are present,
THEN
SELECT the tower that best represents the release point height.
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• .~OTEI
j Only ONE on-site tower may be used at one time. j

___ ICurrently URI only uses the FCS meteorological tower for input. ___

C. IF the meteorological data is available from the plant computer system,
T'H EN
ENTER the Wind Speed in the appropriate units.

1. ENTER the Wind Direction the wind is coming FROM.

2. ENTER the AT or the Stability Class directly.

4.4,9 IF the meteorological data is not available from the plant computer system,
THEN
SEE Attachment 2 for further instructions for determining Wind Speed, Wind
Direction and Stability Class.

4.4.10 SELECT the precipitation status that best represents the current
precipitation.-

A. IF precipitation is unknown,
THEN
SELECT "None" from the dropdown list. The following can be used as
guidance:

* None - No rain or snow (most conservative).
* Light Rain - Drizzle, < 0.1 inches / hour.
* Moderate Rain - Heavy Drizzle, 0.1 to 0.3 inches / hour.
* Heavy Rain - > 0.3 inches / hour.
* Light Snow - Visibility > 0.63 miles.
* Moderate Snow - Visibility 0.31 to 0.63 miles.
* Heavy Snow - Visibility < 0.31 miles.

4.4.11 ENTER the optional Off-Site meteorological tower data as applicable.

4.4.12 SELECT the applicable tower(s).

4.4.13 ENTER the Wind Speed in the appropriate units.

O 4.4.14 ENTER the Wind Direction the wind is coming FROM.

4.4.15 ENTER the Stability Class Directly.
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4.4.16 IF a stability class is not provided,
THEN
ENTER the same stability class that was used for the selected On-Site tower.

4.4.17 SELECT the precipitation status that best represents the current precipitation
around the Off-Site tower site using the same criteria as described for the
On-Site tower.

4.4.18 DETERMINE the Reactor Status as follows:

A. IF the Source Term is Normal Coolant or Reactor Core Accident
AND for Non-ATWS events,
THEN
PERFORM the following:

1. IF the reactor is NOT shutdown,
THEN
ENSURE the Reactor Shutdown checkbox is unchecked.

2. IF the reactor is shutdown,
iO THEN

PERFORM the following:

a. CHECK the Reactor Shutdown checkbox.

b. ENTER the Date and Time the reactor was shutdown.

B. IF the Source Term is Normal Coolant or Reactor Core Accident
AND for ATWS events,
THEN
PERFORM the following:

1. IF the reactor power is >=2%,
THEN
ENSURE the Reactor Shutdown checkbox is unchecked.

2. IF the reactor power is <2%,
THEN
PERFORM the following:

a. CHECK the Reactor Shutdown checkbox.

b. ENTER the date and time the reactor power was reduced
.- ,- below 2%.
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4.4.19 IF" the Source Term is Spent Fuel Accident,
THEN
CHECK the Last Irradiated checkbox.

4.4.20 IF" it can be determined when the fuel assemblies involved were last in the
core,
THEN
ENTER the most recent date and time.

4.4.21 IF" the date the fuel assembly was last in the reactor can not be determined,
THEN
PERFORM the following:

A. IF the fuel involved in the accident was removed from the reactor within
the last six months
OR it can not be determined,
THEN
SELECT New. The Reactor Status, Last Irradiated date will be set
automatically.

B. IF" the fuel involved in the accident was removed from the reactor more
than six months ago, •_
THEN
SELECT Old. The Reactor Status, Last Irradiated date will be set
automatically.

4.4.22 IF the source term is from a Waste Gas Decay Tank,
THEN
PERFORM the following:
A. IF the Date and Time the tank was isolated can be determined,

THEN
CHECK the Reactor Status checkbox and ENTER the date and time the
tank was isolated.

B. IF" the Date and Time can not be determined,
THEN
ENSURE the Reactor Status checkbox is NOT checked.

4.4.23 IF any other source term was selected,
THEN
ENSURE the Reactor Status checkbox is NOT checked.

4.4.24 DETERMINE the Release Duration (default is 4-hours).

A. ENTER the estimated Release Duration.
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4.4.25 OPEN the Pathways form to determine the release point Pathway as follows:

A. SELECT the pathway that BEST represents the release in progress.

I Additional detail for each pathway, including available effluent monitors and j
• methodologies, is available by hovering the mouse over each pathway

____button to the right of the form. ___

4.4.26 DETERMINE the correct process reduction settings and (if applicable) Spent
Fuel Pool condition using the descriptions in Attachments 11 and 12.
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u• Dpendng o patwayNOTE prcse

Deenig nthe selected pahareduction poesswill be enabled or i

I disabled. If disabled, then they are not included in the pathway reduction
_____factor calculation. ___

4.4.27 DETERMINE the methodology to be used for the dose assessment.

A. Monitored Release - Uses installed effluent monitors. Go to Step
(4.4.28).

B. Containment Leakage - Uses the coolant or core conditions including
percent core damage or containment high radiation monitor readings.
Go to Step (4.4.31).

C. RCS Leakage - Uses a Reactor Coolant System leak rate. Go to Step
(4.4.34).

D. Release Point Sample - Uses actual effluent sample results in uCi/cc.
Go to Step (4.4.35).

E. Field Team - Back calculates based on field team survey and sample
results. Go to Step (4.4.36).

F. Unmonitored Spent Fuel - Tab is selected when the Un-Monitored Spent
Fuel Accident with No other method available check box is selected.
There are no user inputs on the Tab frame. The Unmonitored spent fuel
method uses extent of core involved, pool condition, process reduction
factor, fuel damage condition and release duration to determine a gross
release rate that is not scaled to any plant measurement. Go to Step
(4.4.38).

4.4.28 Monitored Release

A. SELECT the effluent most appropriate monitor.

B. ENTER the monitor reading for the selected monitor.
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NOTE

Depending on the pathway selected and the associated selected monitor
i additional flow rate data may be required. j

Ten (10) mile dose assessments are normally selected. Use 50-miles, if 10-
mile assessment indicated doses are exceeding protective action
recommendations beyond 10-miles.

C. DETERMINE applicable flow related data as follows:

1. IF a Release Point Flow Rate is requested,
THEN
ENTER the flow rate in the units requested.

a. Some sites release point flow rates for certain release points
may not be available from the sites plant display system.

2. IF a Calculated SIG Flow Rate is requested,
THEN
ENTER the following for the FAULTED STEAM GENERATOR
ONLY:

* Pressure
* Number of SRV's (Large Main Steam Safeties) or PORV's (Small

Main Steam Safeties, MS-291 or MS-292) open
* ADV's (HCV-1 040) open

3. IF a Calculated Steam Table Flow Rate is requested,
THEN
PERFORM the following:

a. SELECT either Temperature or Pressure from the options and
ENTER the corresponding system parameter.

b. ENTER the Mass Flow rate of the faulted generator only or
ADV
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4.4.29 IF all errors have been resolved,
THEN
PRESS the 10 Miles or 50 Miles button on the Process Assessment frame to
run the dose assessment.

• ~NOTEi

II Use 50 miles if it is expected that the doses may exceed PARs at or
• beyond10 miles. The 50 mile assessment does NOT provide doses within

____10 miles. Use the 10 mile assessment for information within 10 miles. ___

4.4.30 GO TO "Dose Assessment Results" below.

4.4.31 Containment Leakage

A. SELECT the appropriate Method from any enabled options.

B. IF % Fuel Damage is selected,
THEN
ENTER the percent damage that corresponds to the Source Term, Type

'4
~of Damage (Clad or Melt).

C. IF the Containment Radiation Monitor is selected,
THEN
ENTER the corresponding high range radiation monitor reading.

D. DETERMINE the appropriate containment gas space volume Release
Mode from the enabled options as follows:

1. SELECT "Leakage" when using the default percent primary
containment leakage or a percent leakage determined through
calculation.

2. ENTER the leak rate as a percent. To determine the preset default
leakage, hover the mouse over the textbox.

3. IF the primary containment gaseous volume is leaking due to
isolation failures, such as open valves or failed penetrations that do
not meet the requirement of a Catastrophic Failure,
THEN
SELECT "Failure to Isolate".

(,d• 4. IF the primary containment has at least a 1-ft2 hole providing a direct
release path to the environment,
THEN
SELECT "Catastrophic Failure".
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5. SELECT "Calc'd Cont. Leak Rate" when using a calculated leak rate
and ENTER the leak rate in cfm. Default is 1 .5-cfm (0.2%/24-hrs)

4.4.32 IF all errors have been resolved,
THEN
PRESS the 10 Miles or 50 Miles button on the Process Assessment frame to
run the dose assessment.

IIB expected ~ NOTE maor •

Use 50 miles if it is exetdthat the doses myexceed PARs at ori

• beyond 10 miles. The 50 mile assessment does NOT provide doses within
____10o miles. Use the 10 mile assessment for information within 10 miles. ___

4.4.33 GO TO "Dose Assessment Results" below.

4.4.34 RCS Leakage

A. SELECT the appropriate Method from any enabled options. i

B. IF % Fuel Damage is selected,
T'HEN
ENTER the percent damage that corresponds to the Source Term, Type
of Damage (Clad or Melt).

C. DETERMINE the appropriate RCS liquid leakage Release Mode from the
enabled options as follows:

1. IF the leak rate is unknown,
THEN
SELECT "Unknown Leak Rate".

2. IF the leak rate is known,
THEN
SELECT "Calculated RCS Leak Rate" and ENTER the coolant leak
rate in gpm.

D. IF all errors have been resolved,
T"HEN
PRESS the 10 Miles or 50 Miles button on the Process Assessment
frame to run the dose assessment
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m• ~ ~NOTEma
Use 50 miles if it is expected that the doses myexceed PARs at ori

• beyond10 miles. The 50 mile assessment does NOT provide doses within
* 10 miles. Use the 10 mile assessment for information within 10 miles. ___

E. GO TO "Dose Assessment Results" below.

4.4.35 Release Point Sample

A. ENTER the release point flow rate in cfm.

B. ENTER the release concentrations in pCi/cc for each corresponding

isotope.

NOTE

•• Release point sample should be used only if noble gas, iodine and
Sparticulate data is available. Leaving a class of effluent blank will cause the

dose assessment to be incomplete but if values are actually zero, that is
acceptable for a complete dose assessment.

C. IF all errors have been resolved,
T-HEN
PRESS the 10 Miles or 50 Miles button on the Process Assessment
frame to run the dose assessment.

• ~NOTEi

m use 50 miles if it is expected that the doses may exceed PARs at or
• beyond 10 miles. The 50 mile assessment does NOT provide doses within

____10 miles. Use the 10 mile assessment for information within 10 miles,

0. Go to "Dose Assessment Results" below.

4.4.36 Field Team results

A. ENTER the downwind distance in miles the sample was taken. The
program assumes the sample was taken at or close to the plume
centerline.

Ditnemy o xed 0mlsNOTE
I isane ayno eced 0 ilsand 50 mile assessments are not-

J available in the Field Team method.

B. ENTER the closed window exposure rate in mR/hr.
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4.4.37 Field Team air sample results

A. IF a field team air sample IS available,
THEN
PERFORM the following:

1. USE the air sample calculator tool in URI to calculate a field team
sample result as described in Attachment 4.

2. IF the concentration is < the calculated Lower Limit of Detection
(LLD),
THEN
ENTER 0,
OTHERWISE
ENTER the 1-131 concentration in IJCi/cc.

B. The Air Sample Calculator provides a button to transfer the air sample
result to the field team assessment form.

O C. IF a field team air sample result is NOT available,
THEN ..
BLANK the 1-131 concentration value. Do NOT enter 0. Entering zero
will cause the iodine and particulate source term to be set to zero.

D. ENTER the time the field team survey data was taken.

E. IF all errors have been resolved,
THEN
PRESS the 10 Miles button on the Process Assessment frame to run the
dose assessment.

F. GO TO "Dose Assessment Results" below.

4.4.38 Unmonitored Spent Fuel

A. IF all errors have been resolved,
THEN
PRESS the 10 Miles or 50 Miles button on the Process Assessment
frame to run the dose assessment.
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U i i
| Use 50 miles if it is expected that the doses may exceed PARs at or
• beyond10 miles. The 50 mile assessment does NOT provide doses within

____10 miles. Use the 10 mile assessment for information within 10 miles. ___

B. GO TO "Dose Assessment Results" below.

4.4.39 Dose Assessment Results

A. To print or preview the dose assessment results, SELECT one of the
options from the toolbar on the assessment method tab. The following
reports are available.

1. Dose Assessment Report - This report contains assessment results
and release information. It may be:

a. Previewed from the print preview toolbar button (page and
magnifying glass icon).

b. Printed to the default printer from the print toolbar button
(printer icon).

c. Printed to a Microsoft XPS document file from the print toolbar
button (printer icon). The file can be attached to e-mail or
WebEOC forms for distribution and viewed via Microsoft's
Internet Explorer.

2. Receptor Point Report - This report contains calculated values for
the predetermined receptor points. It may be:

a. Previewed from the print preview toolbar button.

b. Printed to the default printer from the print toolbar button.

c. Printed to a Microsoft XPS document file from the print toolbar
button. The file can be attached to e-mail or WebEOC forms
for distribution and viewed via Microsoft's Internet Explorer.

3. Evacuation Area Graphic - Provides a graphic of the sectors / areas
that exceed the General Emergency Protective Action Guideline
values for this dose assessment only (globe icon). This graphic is
printed on the dose assessment report.



EPIP-EOF-6 Reference Use Page 25 of 47
Offsite Dose Assessment Using the Rev. 49
Unified RASCAL Interface

4. Results may be viewed or printed on a map. From the Detailed
Assessment main menu or toolbar, SELECT View => View Receptor
Point Locations or select the world icon at the upper left.

a. SELECT the 2, 5 or 10 mile map to view for 10 mile
assessment. 50 mile map view is preset for 50 mile
assessment.

b. SELECT the footprint results for either TEDE Dose or ODE
Thyroid Dose.

c. SELECT a map Zoom Level.

d. SELECT the Display Options

1) RASCAL Sector Results - Draws the 36 NRC sectors on
the map which represents the close in doses to ~ 2.25
miles (10 mile assessment) or ~11 miles (50 mile
assessment). RASCAL sectors are 100 each, split into 8
distance segments. Sector 1 starts at 50 and arcs in a
clockwise direction.

2) RASCAL Puff Results - Draws the 41 x 41 grids on the
map which represents the doses beyond 2.25 miles (10
mile assessment) or 10 miles (50 mile assessment).
Column 1 is on the left with row 1 on the bottom.

3) Sectors - Displays the classic 16, 22.50 sectors.

4) Mile Circles - Displays the 2, 5 and 10 mile distances for
10 mile assessment and 10, 25 and 50 mile distances for
50 mile assessment.

5) Receptor Points - Displays the preset points of interest.
Additional information can be obtained by double clicking
each point as needed.

6) Show Balloon - Displays an information balloon when the
mouse is dragged across the map.

e. SELECT Print Current View to print the contents of the map
displayed in the window to the default printer.

f. SELECT Print View to XPS to print the contents of the map
displayed in the window to a Microsoft XPS document file. The
file can be attached to e-mail or Web forms for distribution and
viewed via Microsoft's Internet Explorer.
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4.4.40 PROVIDE the dose projection to the Dose Assessment Coordinator or
Protective Measures Manager for comparison to the Emergency Action
Levels and the Current Protective Action Recommendation.

4.4.41 No protective action recommendations are made by the dose assessment
software. USE the protective action procedure to determine the appropriate
response to the dose assessment results.
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7 N

4.5 Sum Assessment

4.5.1 SELECT Sum Assessment from the File menu or toolbar (blue Sigma icon).

4.5.2 DETERMINE the summation as follows:

A. SELECT the existing assessment results to sum.

I Sumedassesmets soul beconcurrent- within minutes of each other I
____or ongoing and overlapping. ___

B. ENTER (type or drag-and-drop) the file names in the file name grid.

i 10 and 50 mile assessments will not sum.j

____Up to five concurrent assessments may be summed. ___

C. ENABLE or DISABLE entered files by selecting the Include checkbox
on each line.

4.5.3 Dose Assessment Results

A. To print or preview the dose assessment results, SELECT one of the
options from the toolbar on the assessment method tab. The following
reports are available.

1. Dose Assessment Report - This report contains assessment results
and release information. It may be:

a. Previewed from the print preview toolbar button (page and
magnifying glass icon).

b. Printed to the default printer from the print toolbar button
(printer icon).

c. Printed to a Microsoft XPS document file from the print toolbar
button (printer icon). The file can be attached to e-mail or
WebEOC forms for distribution and viewed via Microsoft's
Internet Explorer.

d. Evacuation Area Graphic - Provides a graphic of the
sectors/areas that exceed the General Emergency Protective
Action Guideline values for this dose assessment only (globe
icon). This graphic is printed on the dose assessment report.

)

}
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e. Results may be viewed or printed on a map. From the Detailed
Assessment main menu or toolbar, SELECT View => View
Receptor Point Locations or select the world icon at the upper
left.

2. SELECT the 2, 5 or 10 mile map to view for 10 mile assessment. 50
mile map view is preset for 50 mile assessment.

3. SELECT the footprint results for either TEDE Dose or CDE Thyroid
Dose.

4. SELECT a map Zoom Level.

5. SELECT the Display Options:

a. RASCAL Sector Results - Draws the 36 NRC sectors on the
map which represents the close in doses to ~2.25 miles (10
mile assessment) or ~ 11 miles (50 mile assessment).
RASCAL sectors are 100 each, split into 8 distance segments.
Sector 1 starts at 50 and arcs in a clockwise direction.0 b. RASCAL Puff Results -Draws the 4l x 41 grids on the map

which represents the doses beyond 2.25 miles (10 mile
assessment) or 10 miles (50 mile assessment). Column 1 is on
the left with row 1 on the bottom.

c. Sectors - Displays the classic 16, 22.50 sectors.

d. Mile Circles - Displays the 2, 5 and 10 mile distances for
10 mile assessment and 10, 25 and 50 mile distances for 50
mile assessment.

e. Receptor Points - Displays the preset points of interest.
Additional information can be obtained by double clicking each
point as needed.

f. Show Balloon - Displays an information balloon when the
mouse is dragged across the map.

6. SELECT Print Current View to print the contents of the map
displayed in the window to the default printer.

7. SELECT Print View to XPS to print the contents of the map
displayed in the window to a Microsoft XPS document file. The file

-O can be attached to e-mail or WebEOC forms for distribution andK.' viewed via Microsoft's Internet Explorer.
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4.5.4 PROVIDE the dose projection to the Dose Assessment Coordinator or
Protective Measures Manager for comparison to the Emergency Action
Levels and the Current Protective Action Recommendation.

4.5.5 No protective action recommendations are made by the dose assessment
software. USE the protective action procedure to determine the appropriate
response to the dose assessment results.

4.6 Liquid Dose Projections

4.6.1 START the Liquid Dose Project spread sheet using EXCEL.

4.6.2 DETERMINE if the liquid effluent monitors are available.

I The liquid release software assumes no dilution.I

A. In some cases the effluent monitors may not be available even if they are
associated with a liquid release pathway due to plant conditions, such as
loss of power, sample flow or detector failure.

4.6.3 IF the effluent monitor is available for a liquid pathway
THEN
ENTER the monitor count rate for that pathway and calculated the
concentration

A. ENTER the calculated concentration for that pathway in the WATER
SAMPLE cell of the spread sheet.

4.6.4 IF the water sample was analyzed from the effluent pathway
OR is from runoff that was analyzed
THEN enter the total concentration in the WATER SAMPLE cell of the
spread sheet.

4.6.5 ENTER the release flow rate in the RELEASE FLOW RATE cell of the
spread sheet
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NOTE

Missouri river flow rate can be found on the National Weather Service web
• page "Advance Hydrological Prediction Services" for near Decatur. Click on'iI chart to display river flows. I

S http://water.weather.gov/ahps2/hydrograph to xml.php?gage=dctnlI &outpu
____t=tabular ___

4.6.6 ENTER the River flow rate in the RIVER FLOWRATE cell of the spread
sheet.

A. IF the river flow rate is unknown
THEN use 28,369-ft3/s.

• ~NOTEi

I The EPA has not proposed a specific drinking water Protective Actionji Guideline at this time. The current EPA standard under the Safe Drinking
____Water Act is 4-mrem per year.___

4.6.7 PROVIDE the dose projection to the Shift Manager, Dose Assessment
Coordinator or Protective Measures Manager for comparison to the
Emergency Action Levels and the Current Protective Action
Recommendation.

4.6.8 No protective action recommendations are made by the dose assessment
software. USE the protective action procedure to determine the appropriate
response to the dose assessment results.

5.0 RETENTIONIRECORDS

None

6.0 REFERENCES AND COMMITMENTS

None

7.0 ATTACHMENTS

7.1 Attachment 1, URI Computer Program Loading Instructions

7.2 Attachment 2, Alternate Meteorology Methodologies

7.3 Attachment 3, Pre-Calculated Release Point Flow Rates

7.4 Attachment 4, Air Sample and Thyroid Dose Calculations
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7.5 Attachment 5, Conversion Calculations

7.6 Attachment 6, Distance and Bearing

7.7 Attachment 7, Time to Threshold

7.8 Attachment 8, EDE to TEDE Ratios

7.9 Attachment 9, Detailed Source Term Data

7.10 Attachment 10, left intentionally blank

7.11 Attachment 11, Process Reduction Factor Determination for Pressurized Water
Reactors

7.12 Attachment 12, Spent Fuel Pool Status Selection
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Attachment 1 - URI Computer Program Loading Instructions

In the event the URI computer program does not run when initiated, the following instructions
are provided to allow for the loading of the program. Loading of the program should be
performed by IT personnel when they are available. If IT is not available the user should
attempt to go to another computer that has the URI software loaded and attempt to run it from
there before attempting to load the software on another computer.

1.0 INSTRUCTIONS FOR LOADING THE URI PROGRAM

1.1 LOCATE the URI program disks in the Control Room, TSC, or EOF.

1.2 LOCATE the site URI program on the disk.

1.3 COPY the contents of the applicable URI program folder to a corresponding folder on
the target computer.

1 .3.1 IF the folder already exists,
THEN it is recommended the entire folder be replaced with the folder on the
disk.

NOTE

The program files copied from the URI CD to the URI folder, sub foldersi[ and files are cannot be NOT read only. Files copied from CD are [

IIautomatically set to read-only. URI must be able to read write to the folders I
and individual files or the program will not start properly. The RASCAL
engine will give a "fatal Fortran error" if unable to write to the folder and

___other files (.e.g., MOBSPROC.dbg).___

1.4 ATTEMPT TO start the program by double clicking the URI executable file on the
target computer.

1 .5 An assessment must be run to ensure all the files are in place to complete the
calculation and printing can be performed. It is recommended this be performed by
someone who does NOT have administrative rights to the computer.

1.6 IF the program is being installed by IT,
THEN
VERIFY all common shortcuts to the program as time permits.
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Attachment 2 - Alternate Meteorology Methodologies

1.0 INSTRUCTIONS

1 .1 IF the site meteorological data is unavailable from the plant computer system,
T"HEN
OBTAIN the following data from another source:

* Wind Speed - Make sure the supplied speeds are in the same units as those
used by the selected meteorological tower.

* Wind Direction FROM - If wind directions are supplied as compass points (N,
NNE, NE, etc.) then they can be converted directly by double clicking the
corresponding cell in the table and selecting the direction.

* Stability Class or Delta T - Make sure the supplied Delta T values are in the
same units as those required in Tables 2-1

1.2 OBTAIN the data in the following preferred order

* Control Room Meteorological Instruments.

* National Weather Service via the NWS web site. See Table 2-1 for
determination of Stability Class

* Broadcasted data such as alert radio systems, broadcast radio or television
stations or transcribed automated data from local airports. See Table
Attachment 2-1 for determination of Stability Class

* Direct Observation Estimate at the site. See Table Attachment 2-1 for
determination of Stability Class

;ii• ;••i••i: ii•••-i~l~i!i;.•• i;•:!• •••,;i ii T able Attac:hment 2-l1 . i ;i`:; !•: . ii•••: : :

SraeDaytime Solar Radiation ____ Nighttime Conditions

Wind For moderate cloud cover move one
Spedcoum t te igtOvercast (>1/2 cloud cloud Overcast

(mph) Summer Spring/Fall Winter Rain cover) cover Rain
Clear Sky Clear Sky Clear Sky___________

< 9.0 A A-B B D F G D
9.0 A-B B C D E F D

tol13.5 B B-C C D D E D
> 13.5 c C-D D D D D D

K 2
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Attachment 3 - Pre-calculated Release Point Flow Rates

Predetermined flow rates for some release pathways and points that are not displayed
on the plant computer systems. Those fixed flow rates are listed below.
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Attachment 4 - Air Sample and Thyroid Dose Calculations

1.0 INSTRUCTIONS

1.1 From the Detailed Assessment Form menu, SELECT Calculations => Air Sample

Calculations.

II Many of the options available on the form will not be active due to thej
• particular air sampling and counting processes used at the individual sites.

_____If not active proceed to the next step. ___

1.2 SELECT the Particulate Filter counting equipment.

1.3 IF a particulate filter is not available,
THEN
SELECT "None".

1.4 IF the field team used a Count Rate Meter to count the particulate filter,
THEN .
SELECT the specific meter used. '

1.5 ENTER the count rate meter Background Count Rate in CPM.

1.6 ENTER the particulate filter gross Count Rate in CPM.

1.7 IF the field team used a Counter (scaler) to count the particulate filter,
THEN
SELECT the specific meter used.

1 .8 ENTER the Background Count Time in minutes.

1.9 ENTER the Background counts.

1.10 ENTER the Filter Count Time in minutes.

1.11 ENTER the particulate filter gross counts.

1.12 SELECT the Iodine Cartridge counting equipment.

1 .13 IF an iodine cartridge is not available,
THEN
SELECT "None".

1.14 IF the field team used a Count Rate Meter to count the iodine cartridge,
THEN
SELECT the specific meter used.
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1.15 ENTER the count rate meter Background Count Rate in CPM.

1.16 ENTER the iodine cartridge gross Count Rate in CPM.

1 .17 IF the field team used a Counter (scaler) to count the iodine cartridge,
THEN
SELECT the specific meter used.

1.18 ENTER the Background Count Time in minutes.

1.19 ENTER the Background counts.

1.20 ENTER the cartridge Count Time in minutes.

1.21 ENTER the cartridge gross counts.

1.22 If the sample was returned with a flow rate and a sample collection time, then
SELECT "Utilize Flow Rate and Sample Collection Ties

1.23 SELECT the appropriate flow rate, CFM or [PM.

1.24 ENTER the sample flow rate.

1.25 ENTER the sample collection time in minutes.

1.26 IF the sample was returned with a total flow,
THEN
SELECT "Enter Total Flow".

1.27 SELECT the appropriate volume units, Cubic Feet or Liters.
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1.28 ENTER the total sample flow.

1 .29 Once all errors have been resolved, partic~ulate filter and iodine cartridge results
in IpCi/cc will be calculated along with a Lower Limit of Detection (LLD)

1.30 If the net sample results are below the calculated LLD, the LLD in the
corresponding units will be displayed. The resultant value will NOT be used in
the calculated total I-131 concentration.

1.31 If the net sample results are at or above the calculated LLD, the calculated 1-131
concentration will be displayed. The resultant value will be used in the calculated
total I-131 concentration.

1.32 PRESS the "Transfer to Field Team Calc" button to automatically enter the
calculated total 1-131 concentration in the 1-131 Conc. textbox on the Field Team
tab.

1.33 IF an Optional Estimated Thyroid Dose Calculation is needed,
THEN
ENTER the time the team was in the plume in hours in the Exposure Time
textbox. The estimated Thyroid Dose in remn will be calculated.

1.34 PRESS Print to print the sample results report.

1.35 PRESS Cancel to exit and close the form.
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Attachment 5 - Conversion Calculations

URI provides methods to perform conversion calculations to recalculate data obtained
from other non-standard sources to units usable within URI. Conversion calculations
exist to convert:

* Concentrations and flow rates to release rates
* Distances
* Velocities
* Volumes

From the Detailed Assessment form menu, SELECT Calculations => Conversion
Calculations

ENTER the value(s) into the appropriate textboxes

SELECT the units to match the entered value(s)

SELECT the units to convert to.
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Attachment 6 - Distance and Bearing

1.0 INSTRUCTIONS

1.1 URI provides methods to determine distance and bearing from any two points
given a latitude and longitude of each. These can be either predetermined fixed
points or any two points consisting of a latitude and longitude. This can be useful
if field teams return survey result locations in geographic coordinates.

1.2 From the Detailed Assessment form menu, SELECT Calculations => Distances
and Bearings

1.3 SELECT the data format to use for inputting coordinates.

1.4 SELECT the method which best meets the data supplied

1 .5 Point to Point - Determines the distance and bearing based strictly on
predetermined receptor points. The user cannot enter or modify any point
locations

1.6 SELECT the Point A Receptor Point of interest.

1.7 SELECT the Point B Receptor Point of interest.

1.8 The Distance and Bearing will be calculated from Point A to Point B.

1.9 Point to Any Lat/Lon - Determines the distance and bearing based on a
predetermined receptor point and any entered Latitude and Longitude.

1.10 SELECT the Point A Receptor Point of interest.

1.11 ENTER the Point B Latitude and Longitude. Latitudes north of the equator are
Positive values. Longitudes west of the Prime Meridian are Negative values.

1.12 The Distance and Bearing will be calculated from Point A to Point B.

1.13 Any Lat/Lon to Any Lat/Lon - Determines the distance and bearing based on any
entered Latitude and Longitude.

1.14 ENTER the Point A Latitude and Longitude. Latitudes north of the equator are
Positive values. Longitudes west of the Prime Meridian are Negative values.

1.15 ENTER the Point B Latitude and Longitude. Latitudes north of the equator are
Positive values. Longitudes west of the Prime Meridian are Negative values.

1.16 The Distance and Bearing will be calculated from Point A to Point B.
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Attachment 7 - Time to Threshold

1.0 INSTRUCTIONS

1.1 URI provides a time to threshold report that calculates when the threshold will be
exceeded at each of the predetermined RASCAL reporting distances. The report
uses the highest dose calculated for each distance divided by the release
duration to obtain a rate. This rate is then used to calculate the number of hours
and minutes until each of the thresholds is exceeded. This report:

1.1.1 Does not account for any subsequent decay of deposited radionuclides
over the displayed time frame.

1.1.2 Reported times do not account for previously released doses or
deposition due to previous releases.

1 .1 .3 Thresholds are reported for the Unusual Event, Alert, Site Area
Emergency and General Emergency classifications.

1 .2 If no threshold value was set by the administrator for a classification N/A is
reported.

1.3 If a calculated time to threshold exceeds 100 hours >1 00:00 is displayed.

1.4 SELECT the Print button to print the report to the default printer.
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Attachment 8 - EDE to TEDE Ratios

1.0 INSTRUCTIONS

1.1 URI provides a report that calculates the ratios of EDE to TEDE with Iodine and
without Iodine. These ratios are useful in determining how readings on external
dosimeters (Deep Dose Equivalent) might correspond to TEDE values.

1.2 From the Detailed Assessment form menu, SELECT Calculations => EDE to
TEDE Ratios

1.3 Ratios will be calculated for the key distances of 2, 5 and 10 miles.

1 .4 EDE/TEDE Ratio with Iodine is an indication of the amount of iodine in the
release mix. The greater the amount of iodine the greater the whole body dose
that may not be measured on a self-reading dosimeter. As the ratio gets smaller
(approaches 0) the actual TEDE will increase but will not be accounted for on the
self-reading dosimeter. Dose limits should be adjusted accordingly to ensure
TEDE is not exceeded if individuals such as field team members or emergency
workers will be entering these areas.

1 .5 Some states require these ratios to perform dose limit calculations. The
calculated ratios can be printed and supplied to the state as needed.
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Attachment 9 - Detailed Source Term Data

Though each URI printed dose assessment report provides a calculated release rate,
additional source term data is available that might be useful to external entities
performing dose assessments using other assessment programs. This report contains
a complete listing of the isotopes of interest, isotopic half-life, process reduction factor
effects and available fractions.

1. From the Detailed Assessment form menu, SELECT Calculations => Source
Term Data

2. The calculated source term data will be displayed
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0
Attachment 10 - Left Intentionally blank
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Attachment 11 - Process Reduction Factor Determination for Pressurized Water Reactors

1.0 INSTRUCTIONS

1.1 DETERMINE the Holdup Times as follows:

1.1.1 IF the holdup time is not applicable to the actual release pathway,
THEN
SELECT Specific Time and ENTER 0 hours.

1.1.2 Turbine Building

A. SELECT < 2 Hours if ventilation is running.

B. IF ventilation is off,
THEN
SELECT best option based on estimated building leakage rate or
SELECT <2 hours if unknown.

1 .1 .3 Auxiliary Building

A. SELECT < 2 Hours if ventilation is running

B. IF ventilation is off,
THEN
SELECT best option based on estimated building leakage rate or
SELECT <2 hours if unknown.

1.1.4 Primary Containment

A. IF the affected volume has remained static with no significant additions
to the source term
AND a specific holdup time can be determined,
THEN
SELECT the appropriate range from the options provided
OR
SELECT the Specific Time option and ENTER the holdup time in hours.

B. IF the affected volume has not remained static with significant additions
to the source term,
THEN
SELECT < 2 hours. This is the normally selected option if fuel damage
is on-going.
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C. IF 'Catastrophic Failure' is selected as the basis for flow for the dose
assessment,
THEN
SELECT <2 hours.

1 .2 DETERMINE the spray status as follows:

1 .2.1 IF Spray is not applicable to the actual release pathway,
THEN
SELECT Off.

1.2.2 IF Spray is running,
THEN
SELECT On.

1 .2.3 IF Spray is not running
OR the status of Spray can not be determined,
THEN
SELECT Off.

1 .2.4 IF the volume has remained static with no significant additions to the source
term
AND a specific spray time can be determined,
THEN
SELECT Specific Time option and ENTER the spray run time in hours. This
is NOT a normally selected option if fuel damage is on-going.

1 .3 DETERMINE filter status as follows:

1 .3.1 IF the filter is not applicable to the actual release pathway,
THEN
SELECT Not Working.

1 .3.2 IF the filter is working
OR the status of the filter can not be determined,
THEN
SELECT Working.

1 .3.3 IF the filter is not working,
THEN
SELECT Not Working.

1.4 DETERMINE Steam Generator Status as follows:

1.4.1 IF the Steam Generator wide range level indicator is > 100%,
THEN
SELECT Solid.
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1.4.2 IF the Steam Generator wide range level indicator is < 10%,
THEN
SELECT Dry.

1.4.3 IF the Steam Generator wide range level indicator is >_ 10% and < 100%,
THEN
SELECT Boiling.

1.4.4 IF the Steam Generator water level can not be determined
AND is being fed secondary water,
THEN
SELECT Boiling,
OTHERWISE SELECT Dry.
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Attachment 12 - Spent Fuel Pool Status Selection

1.0 INSTRUCTIONS

1.1 DETERMINE the spent fuel status as follows:

1.1.1 IF the spent fuel pool is normally cooled and the incident involves cooled fuel
under water,
THEN
SELECT 'Under water'.

1.1.2 IF the spent fuel pool is draining, fuel is overheating, the pool may be boiling,
but there is still some heat removal and the fuel is not yet on fire,
THEN
SELECT 'Partially Covered'.

1 .1 .3 IF the pool is essentially dry and a Zr - air reaction (fire) has begun,
THEN
SELECT 'Dry'.

1 .1 .4 IF dry cask incident,
THEN
SELECT Dry Cask.


